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CHAPTER 1 - Introduction 

Tier2 Submit is a software program developed by the Environmental Protection 
Agency (EPA) and National Oceanic Atmospheric Administration (NOAA) for use by 
facilities to enter and submit Emergency Planning and Community Right-to-Know Act 
(EPCRA) 311/312 chemical information, commonly known as Tier II reports. Tier2 
Submit will allow users to enter multiple facilities, chemicals and contacts. The 
program also includes many of the state's additional data requirements. 

You can use Tier2 Submit in two ways: 

●     Facilities: Enter, store, print and export Tier II information for sending to State 
Emergency Response Commissions (SERCs), Local Emergency Planning 
Committees (LEPCs) and Fire Departments. Tier2 Submit is designed to help 
the reporting facility enter the data efficiently and submit the electronic 
information easily.  
 

●     SERCs, LEPCs & Fire Depts: Receive Tier2 Submit files from facilities to 
import into CAMEO or other database applications for emergency planning. 

Tier2 Submit is organized into three modules (parts): 

●     Facilities module - where the user enters business name, address, Standard 
Industrial Code, etc. 

●     Contacts module - where the user enters owner, emergency, and other 
contact's addresses and phone numbers. 

●     Chemicals in Inventory module - where the user enters chemical property 
and storage information, etc. 

The user can navigate to each of these modules freely to add, delete or edit the 
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information. Tier2 Submit has virtually unlimited capacity so even companies with 
thousands of facilities can use the software effectively. Tier2 Submit is also designed 
with basic and advanced search features, so facilities, SERCs, LEPCs and Fire 
Departments can search by county or State for efficient regulatory submission or 
emergency planning tasks. 

 
Getting Tier2 Submit

 
You can obtain the latest Tier2 Submit information and a free copy of the software at 
the Tier2 Submit web site http://www.epa.gov/osweroe1/content/epcra/tier2.htm  
 
 
CAMEO in brief 

CAMEO is a suite of software programs you can use to plan for and respond to 
chemical emergencies. It was developed for frontline chemical emergency planners 
and responders by EPA's Chemical Emergency Preparedness and Prevention Office 
(EPA CEPPO) and the National Oceanic and Atmospheric Administration's Office of 
Response and Restoration (NOAA OR&R). CAMEO includes a set of databases, or 
modules, a toxic gas dispersion model, and an electronic mapping program. CAMEO 
runs on Microsoft Windows and Apple Macintosh computers. 

You can use CAMEO in two main ways: 

●     To access, store, and evaluate information needed for emergency response. 
Firefighters, police officers, and other emergency workers know that a 
response can be hampered by lack of accurate information about the 
substance spilled and safe response actions. CAMEO is designed to help you 
quickly access just such information , when you need it at the scene of a 
response.  
 

●     To develop emergency plans for your community. It's especially designed to 
help you meet the requirements of the Emergency Planning and Community 
Right-to-Know Act (EPCRA, also known as SARA Title III). 

CAMEO initially was developed because NOAA recognized the need to assist first 
responders with easily accessible and accurate response information. Since 1988, 
EPA CEPPO and NOAA OR&R have collaborated to further development of 
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CAMEO. 

 
Note: While CAMEO is highly compatible with Tier2 Submit and an excellent tool for 
emergency planning and response, facilities, SERCs, LEPCs and Fire Depts do not 
need CAMEO to enter and submit Tier II data. 

Getting CAMEO

 
You can obtain the latest CAMEO information and a free copy of the software at the 
CAMEO web site http://www.epa.gov/osweroe1/content/cameo/index.htm  
 
 
Technical Support

 
Tier2 Submit was developed by NOAA and EPA and is now maintained by the RMP 
Reporting Center. For Tier2 Submit technical support, please call 301-429-5018 
or e-mail: userrmp.usersupport@csc.com. Monday-Friday 8am-4:30pm Eastern.  
 
For answers to questions about completing your Tier II information, please see the 
Tier II Instructions or contact the Environmental Protection Agency (EPA) RCRA, 
Superfund & EPCRA Call Center at 1-800-424-9346 or TDD (800) 553-7672. 
Monday-Friday 9am-5pm Eastern.  
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CHAPTER 2 - What do I need to get Started? 

In this chapter, you'll find both the system hardware and software requirements in 
addition to the installation instructions for Tier2 Submit. 

Hardware Requirements 

PC: Intel-compatible Pentium-class computer; 256 MB RAM, hard disk drive with 60 
MB of free hard drive space, SVGA color display.  
 
Macintosh: Macintosh computer with a G3, G4, or G5 processor; 256 MB RAM, 
hard disk drive with 60 MB of free hard drive space. 

 
Software requirements 

You may use Tier2 Submit with either: 
 
PC: Windows 2000 (Service Pack 4), Windows XP (Service Pack 2).  
 
Macintosh: Mac OS 10.3.9 or 10.4.  
 
You also need an Internet browser. 

 
Installation procedures 
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1.  Go to http://www.epa.gov/osweroe1/content/epcra/tier2.htm and follow the 
instructions for downloading Tier2 Submit 2007.  
 
The software can take up to 40 minutes to download from a dial up connection  
 

Important 2006 Users! - DO NOT DELETE Tier2Submit 2006 - You 
may need your old version (Tier2Submit 2006) to export your data into the 
new version (Tier2Submit2007). 

 
 

2.  After the software has downloaded, click on the Tier2Submit Installer icon and 
follow the on screen instructions (Click "Next" and then "Finish" - This will 
create a Tier2Submit2007 folder on your computer's C drive).  
 
 
If you experience any trouble downloading or installing Tier2 Submit 2007, 
please contact the RMP Reporting Center at 301-429-5018 or e-mail: userrmp.
usersupport@csc.com.  

 
 
Import last year's Tier2 Submit data into Tier2 Submit 2007

Note: If you have last year's submission file (zip file created during electronic 
submission) skip to step 2. If you did not create a submission file last year or cannot 
locate it, start at step 1. 

1.  Locate last year's Tier2 Submit program. Go to File on the top menu bar and 
click "Create Submission". Choose "All Records" and click "Start Submission 
Validation". On the next screen click "Electronic File". Next on the "Save As" 
window, name your submission (e.g., AcmeChem2006.zip) and be sure to 
name the file with the .zip extension. On the following screen click the "Done" 
button.  
 
 
Now you have successfully exported your 2006 Tier2 Submit data. Now 
to import into Tier2Submit2007. 
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2.  Open up the Tier2Submit2007 program.  
 
From the Facilities module in Tier2 Submit ( If you are not in the Facilities 
module go to File on the top menu bar and click Open and then select 
Facilities from the list).  
 
Go to File from the top menu bar and click "Import/Export".  
Click the "Import Files" button on the next window.  
On the next window choose "Browse" and find the directory where you saved 
the zip file (Tier2 Submit 2006 submission). Click on the zip file and then click 
the "Open" button. 
Click OK on the pop up window and then the "Done" button. 
 
Congratulations you have successfully imported your 2006 data into 
Tier2Submit2007! 
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CHAPTER 3 - Entering Data 

In this chapter a new user will learn how to enter Tier II facility, contact and chemical 
information into Tier2 Submit. The user will also learn how to validate, print and 
export the data for either a Single Facility or Multiple Facilities  
 
Some points to remember while entering your Tier II information: 

●     There are three parts to the instructions: Entering Data, Validating Data and 
Submitting Data. 
 

●     Federally required fields are marked with a blue asterisk * State required fields 
are marked with a red X. 
 

●     Your data is automatically saved as you enter it, there is no separate "save" 
function. 
 

●     If you need data field descriptions use Tier2 Field Descriptions or State Tier2 
Field Descriptions. 
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Entering Data - Single Facility 

Federally required fields are marked with a blue asterisk *   State required fields are 

marked with a red X. Your data is automatically saved as you enter it, there is no 
separate "save" function  
 
 

Facilities Module  
 

1.  Type in your facility address information and be sure to fill in all the required 
fields (marked with a blue asterisk *)  
 

2.  Next proceed to enter the appropriate data in the Location & ID Tab.  
 
 
  Location & ID   

 
3.  Enter the SIC code(s) and any Dun&Bradstreet 

Numbers if applicable (some states require additional IDs).  
 

Note: You must click once into the blank ID type field to bring up the ID type pull 
down menu.

 
 

4.  Enter the number of employees at the facility.  
 

5.  Enter the facility’s Latitude/Longitude if the state has requested it.  
 
See "How to report a facility latitude and longitude" for further details  
 

6.  Enter method of finding Lat/Long and Description of the Lat/Long location if 
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applicable.  
 

7.  Click the box "Check if chemicals are identical to last years submission" if 
applicable.  
 
Next proceed to the "Contacts" Tab.  
 
 
  Contacts   

 
8.  Read the Federal Contact requirements on the window and 

the additional State Contact requirements (if applicable).  
 

9.  Click the "Add Contact" button.  
 

10.  Enter the Owner/Operator’s contact information. If the Owner Operator is a 
Business name - enter the Business/Corporation Name in the Last Name field.  
 

11.  Choose the phone type from the pull down list and then enter the appropriate 
phone number.  
 

12.  Be sure to choose Owner/Operator from the "Contact Type" pull down list (click 
in the blank field for the pull down list).  
 

13.  Click "Done".  
 

14.  Click the "Add Contact" button again.  
 

15.  Enter the first Emergency Contact’s information.  
 

16.  Choose the 24-hour phone type from the pull down list then enter the 
appropriate phone number.  
 

17.  Choose Emergency Contact from the "Contact Type" pull down list.  
 

18.  Feel free to enter any other phone numbers for the Emergency Contact (24 
hour number is federally required).  
 

19.  Click "Done".  
 
Back at the Contacts Tab  
 

20.  Repeat previous steps for the 2nd emergency contact (if applicable) and for any 
additional state required contacts.  
 
When all contacts have been entered  
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21.  Click on the "State Fields" tab.  
 
 
  State Fields   

 
22.  Enter the appropriate data into any state requested 

fields.  
 
 

Next, click on the  hot button at the top of the Facilities 
module.  
 

Chemicals in Inventory module  
 

23.  Enter Chemical Name (you can use the "Lookup Chemical Name" feature as a 
tool but please not that this list includes additional chemicals that are not 
regulated by EPCRA).  
 

24.  The CAS# may have been entered automatically if you used the "Lookup 
Chemical Name" feature. If not, please enter the CAS# if applicable.  
 

25.  Check off EHS and/or Trade Secret if applicable.  
 
The Physical State & Quantity tab should be open. If not, click the "Physical 
State & Quantity" Tab.  
 
 
  Physical State & Quantity   

 
26.  Check off all Physical States, Hazards and 

Health Effects that apply.  
 

27.  Enter the number of days that the chemical is onsite (1-366).  
 

28.  Actual weight of chemical is required in some states; you must enter actual 
weight in the Average and Maximum fields (if marked with an X).  
 

29.  All states require the Weight Estimate code. Click the field Estimate Code 
Average and Maximum field to choose the chemical’s weight range from the 
pull down list.  
 

30.  Some states require "Max amount in largest container". Enter amount in 
pounds if applicable.  
 

31.  Click the "Storage Locations" tab.  
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  Storage Locations   

 
32.  Choose the appropriate Type, Pressure and 

Temperature storage codes from the pull down lists.  
 

33.  Enter the physical location of the chemical into the Location Field. (If the 
location is confidential type the word "Confidential" button in the Location field).  
 

34.  Enter the amount of the chemical at that particular storage location into the 
"Amount" field and choose the proper unit from the "Units" pull down list.  
 
 

Reminder: Federally required fields are marked with a blue asterisk 
*  
State required fields are marked with a red X.

 
 
 

35.  If the reported chemical is located in multiple places at the facility repeat steps 
32-34 for each location of the reported chemical at the facility.  
 

36.  If the reported chemical is a mixture click the "Mixture Components" Tab if the 
Chemical is a pure substance skip to step 43.  
 
 
  Mixture Components   

 
37.  Check off the EHS field if the mixture 

component is an EHS.  
 

38.  Enter the CAS # of the mixture component.  
 

39.  Enter the Component’s Chemical Name into the Component field (you may 
use the "Lookup Chemical Name" button to find the component’s name).  
 

40.  Enter the percentage of the component in the mixture and choose either 
Weight or Volume from the wt/vol field’s pull down list.  
 

41.  Repeat steps 37-40 if there are multiple components in the mixture.  
 

42.  Click "State Fields" tab.  
 
 
  State Fields   
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43.  Make sure all the appropriate information is entered into 
any state requested fields.  
 
 
Next...  
 

44.  If the facility is reporting multiple chemicals click the  
hot button on the top of the window and repeat steps 23-43 for each additional 
chemical.  
 
After all the chemicals in inventory have been entered  
 

45.  Click the  hot button from the top of the window.  
 

Facilities module  
 

46.  Click the "Certification" Tab  
 
  Certification   

 
47.  Check off the appropriate optional attachments if 

applicable (Some state may require optional attachments).  
 

48.  Type in the name of the owner/operator or the owner/operator's authorized 
representative with official title in the "Signature" Field.  
 

49.  Type the date into the "Date" field (e.g., 02/25/05)  
 
If necessary click the Notes tab and type any notes to the receiving agency  
 
 
 

You have finished entering your first facility's chemical inventory information into 
Tier2 Submit! now on to validation.

 

Validating the data  
 
 

50.  To check all the fields for completion go to the Record menu on the top menu 
bar and click "Validate Record".  
 

51.  If any there is any missing data click the "Go to Field" button on the pop up 
window - If not, click "OK" and skip to step 55.  
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52.  Enter the missing information into the data field and return to the Facility 

record screen ( To quickly navigate to the Facility Record - Go to File from the 
top menu bar and choose Open, then click "Facilities").  
 

Note: You must be in the Facilities module to validate your record.

 
 

53.  Go to the Record menu on the top menu bar and click "Validate Record" 
again.  
 

54.  If there is still missing data repeat steps 50-53 - If not click "OK" and skip to 
Submitting Tier II Report (step 55).  
 

Submitting Tier II reports  
 
Tier2 Submit will only create submissions from the Facilities module - If you 
are not in the Facilities module - Go to File on the top menu bar then select 
"Open" and choose Facilities from the list.  
 
 

55.  Go to the File menu on the top menu bar and click "Create Submission".  
 
Found Set is the default and your Found set is the one facility you just 
entered.  
 

56.  Click the "Start Submit Validation" button.  
 
Validation Passed  
 

57.  Click the "State Submission Requirements" button to review your state's 
reporting procedures for 2007  
 

58.  After reviewing your state's submission requirements - Choose either "Create 
Electronic File" (Go to step 59) or one of the Paper Report options (Go to step 
61) as a submission method, whichever your state prefers.  
 
Electronic Submission  
 

59.  After you have clicked "Create Electronic File", in the "Save As" pop up 
window type the name of the file (make a unique facility identifier (e.g.= ACME 
in Vermont reporting year 2007 = ACME_VT2007.zip).  
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Note: If your state prefers to receive the Tier2 Submit on diskette or CD please save 
the facility's Tier2 Submit file to the media . If your state prefers to have the Tier2 
Submit file e-mailed, save the zip file to an accessible directory so it can be attached 
in an e-mail message. 

 
 

New for 2006 and  2007: Tier2 Submit now has the option to save as a “t2s file” in 
addition to the “zip file” format, due to the increase in zip file restrictions. Both file 
formats will work seamlessly with CAMEOfm and Tier2 Submit. 

 
 

60.  After you have entered a unique filename and chosen the appropriate location 
to save click the "Save" button and the "Done" button on the next screen  
 
 
Paper Submission  
 

61.  After you have clicked "Create Complete Paper Report" or "Create Original 
Style Paper Report".....click the "Print Report" button.  
 

62.  Then click "OK" on the Print set up pop up window (make sure you have 
selected the correct printer).  
 

Congratulations! Now you must either: A.) mail the diskette/CD to your State, 
LEPC and Fire Dept or B.) e-mail the zip file to your State, LEPC or Fire Dept or 
C.) mail the printed report to your State, LEPC and Fire Dept. 

 
 
Note: If you have created an electronic submission zip file, do not attempt to 
open the file directly. These files are designed to only be read by Tier2 Submit 
or CAMEOfm. 
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Entering Data - Multiple Facilities 

Federally required fields are marked with a blue asterisk *   State required fields are 

marked with a red X.  
Your data is automatically saved as you enter it, there is no separate "save" function  
 
 

Facilities Module  
 

1.  Type in your facility address information and be sure to fill in all the required 
fields (marked with a blue asterisk * )  
 

2.  Next proceed to enter the appropriate data in the Location & ID Tab.  
 
 
  Location & ID   

 
3.  Enter the SIC code(s) and any Dun&Bradstreet 

Numbers if applicable (some states require additional IDs).  
 

Note: You must click once into the blank ID type field to bring up the ID type pull 
down menu.

 
 

4.  Enter the number of employees at the facility.  
 

5.  Enter the facility’s Latitude/Longitude if the state has requested it.  
 
See "How to report a facility latitude and longitude" for further details  
 

6.  Enter method of finding Lat/Long and Description of the Lat/Long location if 
applicable.  
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7.  Click the box "Check if chemicals are identical to last years submission" if 

applicable.  
 
Next proceed to the "Contacts" Tab.  
 
 
  Contacts   

 
8.  Read the Federal Contact requirements on the window and 

the additional State Contact requirements (if applicable).  
 

9.  Click the "Add Contact" button.  
 

10.  Enter the Owner/Operator’s contact information. If the Owner Operator is a 
Business name - enter the Business/Corporation Name in the Last Name field.  
 

11.  Choose the phone type from the pull down list and then enter the appropriate 
phone number.  
 

12.  Be sure to choose Owner/Operator from the "Contact Type" pull down list (click 
in the blank field for the pull down list).  
 

13.  Click "Done".  
 

14.  Click the "Add Contact" button again.  
 

15.  Enter the first Emergency Contact’s information.  
 

16.  Choose the 24-hour phone type from the pull down list then enter the 
appropriate phone number.  
 

17.  Choose Emergency Contact from the "Contact Type" pull down list.  
 

18.  Feel free to enter any other phone numbers for the Emergency Contact (24 
hour number is federally required).  
 

19.  Click "Done".  
 
Back at the Contacts Tab  
 

20.  Repeat previous steps for the 2nd emergency contact (if applicable) and for any 
additional state required contacts.  
 
When all contacts have been entered  
 

21.  Click on the "State Fields" tab.  
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  State Fields   

 
22.  Enter the appropriate data into any state requested 

fields.  
 
 

Next, click on the  hot button at the top of the Facilities 
module.  
 

Chemicals in Inventory module  
 

23.  Enter Chemical Name (you can use the "Lookup Chemical Name" feature as a 
tool but please not that this list includes additional chemicals that are not 
regulated by EPCRA).  
 

24.  The CAS# may have been entered automatically if you used the "Lookup 
Chemical Name" feature. If not, please enter the CAS# if applicable.  
 

25.  Check off EHS and/or Trade Secret if applicable.  
 
The Physical State & Quantity tab should be open. If not, click the "Physical 
State & Quantity" Tab.  
 
 
  Physical State & Quantity   

 
26.  Check off all Physical States, Hazards and 

Health Effects that apply.  
 

27.  Enter the number of days that the chemical is onsite (1-366).  
 

28.  Actual weight of chemical is required in some states; you must enter actual 
weight in the Average and Maximum fields (if marked with an X).  
 

29.  All states require the Weight Estimate code. Click the field Estimate Code 
Average and Maximum field to choose the chemical’s weight range from the 
pull down list.  
 

30.  Some states require "Max amount in largest container". Enter amount in 
pounds if applicable.  
 

31.  Click the "Storage Locations" tab.  
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  Storage Locations   
 
32.  Choose the appropriate 

Type, Pressure and Temperature storage codes from the pull down lists.  
 

33.  Enter the physical location of the chemical into the Location Field. (If the 
location is confidential type "Confidential" into the Location field).  
 

34.  Enter the amount of the chemical at that particular storage location into the 
"Amount" field and choose the proper unit from the "Units" pull down list.  
 
 

Reminder: Federally required fields are marked with a blue asterisk 
*  
State required fields are marked with a red X.

 
 
 

35.  If the reported chemical is located in multiple places at the facility repeat steps 
32-34 for each location of the reported chemical at the facility.  
 

36.  If the reported chemical is a mixture click the "Mixture Components" Tab if the 
Chemical is a pure substance skip to step 43.  
 
 
  Mixture Components   

 
37.  Check off the EHS field if the mixture 

component is an EHS.  
 

38.  Enter the CAS # of the mixture component.  
 

39.  Enter the Component’s Chemical Name into the Component field (you may 
use the "Lookup Chemical Name" button to find the component’s name).  
 

40.  Enter the percentage of the component in the mixture and choose either 
Weight or Volume from the wt/vol field’s pull down list.  
 

41.  Repeat steps 37-40 if there are multiple components in the mixture.  
 

42.  Click "State Fields" tab.  
 
 
  State Fields   

 
43.  Make sure all the appropriate information is entered into 
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any state requested fields.  
 
 
Next...  
 

44.  If the facility is reporting multiple chemicals click the  
hot button on the top of the window and repeat steps 23-43 for each additional 
chemical.  
 
After all the chemicals in inventory have been entered  
 

45.  Click the  hot button from the top of the window.  
 

Facilities module  
 

46.  Click the "Certification" Tab  
 
  Certification   

 
47.  Check off the appropriate optional attachments if 

applicable (Some state may require optional attachments).  
 

48.  Type in the name of the owner/operator or the owner/operator's authorized 
representative with official title in the "Signature" Field.  
 

49.  Type the date into the "Date" field (e.g., 02/25/04)  
 
If necessary click the Notes tab and type any notes to the receiving agency  
 
 
 

You have finished entering your first facility's chemical inventory information into 
Tier2 Submit! now on to validation.

 

Validating the data  
 
 

50.  To check all the fields for completion go to the Record menu on the top menu 
bar and click "Validate Record".  
 

51.  If any there is any missing data click the "Go to Field" button on the pop up 
window - If not, click "OK" and skip to step 55.  
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52.  Enter the missing information into the data field and return to the Facility 
record screen ( To quickly navigate to the Facility Record - Go to File from the 
top menu bar and choose Open, then click "Facilities").  
 

Note: You must be in the Facilities module to validate your record.

 
 

53.  Go to the Record menu on the top menu bar and click "Validate Record" 
again.  
 

54.  If there is still missing data repeat steps 50-53 - If not click "OK" and skip to 
Entering data for the next facility (step 55).  
 

Entering data for the next facility  
 

❍     If your next facility is in any way similar to the facility previously entered 
(same addresses, chemicals or contacts) you may duplicate the facility 
and change the appropriate data to save time. To do this go to Record 
on the top menu bar and choose "Duplicate Facility" then proceed to 
repeat steps 1-54 changing the appropriate data when necessary .  
 

❍     If your next facility does not have duplicate or similar information simply 
click the "New Facility" button on the top the window and repeat steps 1-
54.  
 

❍     If you do not have another facility to enter proceed to step 56
 

Submitting Tier II reports  
 
Tier2 Submit will only create submissions from the Facilities module - If you 
are not in the Facilities module - Go to File on the top menu bar then select 
"Open" and choose Facilities from the list.  
 
To create electronic submission files (Tier II Chemical Inventory Reports 
saved on diskette or attached to e-mail) OR printed paper Tier II Chemical 
Inventory Reports for a group of facilities you must first start a Search to 
properly select the facilities you need to submit.  
 

56.  Go to Record on the top menu bar and select "Show all Records".  
 

57.  Go to Search on the top menu bar and select "Start Search".  
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There are several ways you can search Tier2 Submit.  
 
If you would like to submit facilities to a particular State :  
 
        - pick the State from the pull down list and then click the "Search" button.  
 
If you would like to submit facilities to a particular County :  
 
        - type the County into the "County" field and then click the "Search" button.  
 
After your search Tier2 Submit will display the found facilities in the Facilities 
module in List view. 

 
 

58.  Go to the File menu on the top menu bar and click "Create Submission".  
 
Found Set is the default and your Found set are the facilities you just 
searched for (e.g., only ACME Chemical facilities in Vermont).  
 

59.  Click the "Start Submit Validation".  
 
Validation Passed  
 

60.  Click the "State Submission Requirements" button to review your state's 
reporting procedures for 2007  
 

61.  After reviewing your state's submission requirements - Choose either "Create 
Electronic File" (Go to step 62) or one of the Paper Report options (Go to step 
64) as a submission method, whichever your state prefers.  
 
Electronic Submission  
 

62.  After you have clicked "Create Electronic File", in the "Save As" pop up 
window type the name of the file (make a unique facility identifier (e.g.= ACME 
facilities in Vermont reporting year 2007 = ACME_VT2007.zip).  
 

Note: If your state prefers to receive the Tier2 Submit file on diskette or CD please 
save the facilities' Tier2 Submit file to the media or if your state prefers to have the 
Tier2 Submit file e-mailed, save the zip file to an accessible directory so it can be 
attached in an e-mail message. 

 
 

Tier2*Submit User's Manual

10/30/2007 Page 24 of 83



New in 2006 and 2007: Tier2 Submit now has the option to save as a “t2s file” in 
addition to the “zip file” format, due to the increase in zip file restrictions. Both file 
formats will work seamlessly with CAMEOfm and Tier2 Submit. 

 
 

63.  After you have entered a unique filename and chosen the appropriate location 
to save click the "Save" button and the "Done" button on the next screen.  
 
 
Paper Submission  
 

64.  After you have clicked "Create Complete Paper Report" or "Create Original 
Style Paper Report", click the "Print Report" button.  
 

65.  Then click "OK" on the Print set up pop up window (make sure you have 
selected the correct printer).  
 

Congratulations! Now you must either: A.) mail the diskette/CD to your State, 
LEPC and Fire Dept or B.) e-mail the zip file to your State, LEPC or Fire Dept or 
C.) mail the printed report to your State, LEPC and Fire Dept.  
 
If you need to make multiple submissions (to another state or another LEPC) - 
return to step 56 to start a new search and submit again 

 
 
 
Note: If you have created an electronic submission zip file, do not attempt to 
open the file directly. These files are designed to only be read by Tier2 Submit 
or CAMEOfm. 
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Tier2 Submit Field Descriptions 

Facilities

Field Definition Field Description

Facility Name
Enter the full name of your facility (and 
company identifier where appropriate).

Department
Enter the full name of the facility department 
that is reporting 

Street Address
Street full street address or state road of the facility
City city in US or territory where facility is located

County
County, parish, island or district where 
facility is located

Fire District
Local Fire Department District where facility 
is located

State State or Territory where facility is located
Zip 5 digit zip code where the facility is located
Mailing Address

Street
full mailing street address of the facility or 
facility's parent company

City mailing address city
State mailing address State
Zip mailing address zipcode
Country mailing address Country

SIC
Enter the primary Standard Industrial 
Classification (SIC) code
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Dun & Bradstreet Facility Code

Primary Dun & Bradstreet number for the 
facility. The financial officer of your facility 
should be able to provide the Dun & 
Bradstreet number.  If your firm does not 
have this information, contact the State or 
regional office of Dun & Bradstreet to obtain 
your facility number or have one assigned.

RMP
EPA Facility ID given to the facility by the 
EPA for use with Risk Management Plan 
(only if applicable)

NAICS

North American Industry Classification 
System - Industry Classification System that 
is replacing the SIC. For more info visit 
Census - NAICS

Community Right to Know #
Number required by the State of Washington 
for applicable facilities

State ID Number /code given to the facility by the state
Latitude facility latitude
Longitude facility longitude
Method for determining Latitude and 
Longitude

What method did the facility use to obtain 
LAT/LONG

Description of location identified by Latitude 
and Longitude

Where at the facility was the lat /long 
obtained (i.e plant entrance)

Number of employees Number of employees that work at the facility
Check if all chemical in inventory are 
identical to last years submission

 

I have submitted a site plan

Check this box if you have submitted a site 
plan the state, LEPC and fire dept. or are 
going to submit a site plan with the Tier 2 
Submit submission

I have attached a description of dikes and 
other safeguards/measures

Check this box if you are going to attach a 
description of dikes and other safeguards/
measures with the Tier 2 Submit submission

I have attached a list of site coordinates 
abbreviations

Check this box if you are going to attach a 
list of site coordinate abbreviations with the 
Tier 2 Submit submission

Failed Tier2 Submit validation
This box with be automatically checked if the 
report did not pass the minimum 
requirements for submission

State / Local Fees Total Total fees paid
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Signature
Name of Owner/operator or authorized 
representative

Date Signed
Date the Owner/Operator or the authorized 
representative signed the submission

 

Contacts

Field Definition Field Description

First Name

First Name of contact - if entering the owner/
operator DO NOT enter a corporation name if 
this facility is not individually owned. Enter 
the operator.

Last

Last Name of the contact - if entering the 
owner/operator DO NOT enter a corporation 
name if this facility is not individually 
owned. Enter the operator.

Address

Mail address for the contact listed (Only the 
Owner/Operator is federally required). This 
mailing address may contain street address, 
post office box, or rural route number/box 
number

City City name for address listed
State State code for address listed
Zip Zip code for address listed.
Country Country for the address listed
Title Title of the contact
E-mail E-mail address for the contact

Phone Type

Choose a phone type for the contact from this 
field's pull down menu *Reminder 24-hour 
phone is required for the facility's emergency 
contact*

Phone #
type the appropriate phone number into this 
field for each phone type *Reminder be sure 
to include the area code*

Contact Type

Choose the appropriate contact type for each 
contact from this field's pull down menu 
*Reminder both Owner/Operator and 
Emergency Contact are federally required
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Chemicals in Inventory

Field Definition Field Description

CAS #

Chemical Abstract Service (CAS) registry 
number - To find the CAS number of a 
chemical, consult the Material Safety Data 
Sheet (MSDS) for the chemical or product.

Chem Name

Chemical Name - enter the pure chemical, 
trade name, brand name or the company's 
code name for the substance in the space 
provided.

EHS

check off if the chemical reported is an 
Extremely Hazardous Substance or contains 
any ingredients (at a concentration greater 
then 1%) that are on the Extremely 
Hazardous Substances List *Tier 2 Submit 
will automatically check off EHS if an EHS 
chemical is chosen from the "Lookup 
Chemical Name" feature 

Trade secret

DO NOT check off this data field UNLESS 
you are the manufacturer of a trade secret 
product which is being entered under this 
chemical description block. If you are 
withholding the name of a chemical in 
accordance with the criteria specified under 
EPCRA, Section 322, enter the generic 
chemical and check off the trade secret box.

Physical State

●     Pure - check off if the chemical 
reported is a pure substance

●     Mixture - check off if the chemical 
reported is a mixture

●     Solid - check off if the chemical 
reported is a solid when used

●     Liquid - check off if the chemical 
reported is a liquid when used

●     Gas - check off if the chemical 
reported is a gas when used
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Hazards

●     Fire - check off if the chemical is or 
includes products which are 
flammable, combustible liquid, 
pyrophoric, and/or oxidizer as defined 
by 1910.1200 of the Title 29 Code of 
Federal Regulations (CFR)
 
 

●     Pressure - check off if the chemical is 
or includes products which are 
explosive or a compressed gas as 
defined by 1910.1200 of the Title 29 
Code of Federal Regulations (CFR)
 
 

●     Reactive - check off if the chemical is 
or includes products which are 
unstable reactives, organic peroxides, 
and/or water reactive as defined by 
1910.1200 of the Title 29 Code of 
Federal Regulations (CFR)

Health Effects

●     Acute - check of if the chemical is or 
includes products which are highly 
toxic, corrosive, toxic, irritants, 
sensitizers and other chemicals which 
cause an adverse effect to a target 
organ, which manifests itself after a 
long period of time following 
exposure or after repeated contact 
with the substance defined by 
1910.1200 of the Title 29 Code of 
Federal Regulations (CFR)
 
 

●     Chronic - check of if the chemical is 
or includes products which are 
carcinogens, mutagens or teratogens 
and other hazardous chemicals that 
cause an adverse effect to a target 
organ that manifests itself after a long 
period of time following exposure or 
after repeated contact with the 
substance as defined by 1910.1200 of 
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the Title 29 Code of Federal 
Regulations (CFR)
 
 

Chemical information identical to previous 
year

check off this box if the information for this 
chemical is the same as the previous 
reporting year

Days On Site
Total number of days during the calendar 
year the chemical was located at the facility

Maximum Daily Amount

The maximum amount of each chemical at 
your facility should be based on the highest 
quantity of the substance ( in pounds) that 
was stored at any one time during the 
calender year.

Max Code

Maximum Daily Amount Code- the 
maximum range of each chemical at your 
facility should be based on the highest 
quantity of the substance ( in pounds) that 
was stored at any one time during the 
calender year.

Average Daily Amount

The average amount of each chemical at your 
facility should be based on the average 
quantity of the substance ( in pounds) that 
was stored during the calender year.

Avg Code

Average Daily Amount Code - the average 
range of each chemical at your facility should 
be based on the average quantity of the 
substance ( in pounds) that was stored during 
the calender year.

Max Amount in Largest Container

Maximum amount of reported chemical at 
your facility in the largest container (in 
pounds) that was stored at any one time 
during the calender year.
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Storage Codes

●     Type - choose the type of chemical 
storage container that the reported 
chemical was stored in during the 
calendar year from the pull down 
menu in this field
 
 

●     Press - choose the appropriate 
pressure storage code for the reported 
chemical from the pull down menu in 
this field
 
 

●     Temp - choose the appropriate 
temperature storage code for the 
reported chemical from the pull down 
menu in this field

Location

Type the location of each storage container at 
the facility. Each row represents one storage 
location (i.e. Chlorine tank #1 = Building 2 
Quad 4)

Max Amount at Location
Type the maximum amount of the reported 
chemical that was stored at this location 
during the calendar year

Unit
Choose the Unit of measurement for the 
reported chemical at this location (Most 
states prefer pounds)

Mixture Components EHS

Check off if the mixture component reported 
is an Extremely Hazardous Substance or the 
component contains any ingredients (at a 
concentration greater then 1%) that are on the 
Extremely Hazardous Substances List

Mixture Components CAS

Chemical Abstract Service (CAS) registry 
number - To find the CAS number of a 
chemical, consult the Material Safety Data 
Sheet (MSDS) for the chemical or product

Component
Enter the pure chemical, trade name, brand 
name or the company's code name for the 
substance in the space provided

%
Number that represents the percentage of the 
component in the chemical being reported
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Wt/Vol
Choose Wt=weight or Vol=volume from the 
pull down menu to correctly label the 
component's percentage.
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Additional State Tier II Field Descriptions 

Some states request additional information for Tier II Chemical Inventory reports. 
Below is a table of the States that have additional data fields and the corresponding 
descriptions.  
 
 
ALASKA State Additional fields

Max. Daily Amount
Actual maximum daily amount of the 
reported chemical in pounds

Average Daily Amount
Actual average daily amount of the reported 
chemical in pounds

Max. amount per container in pounds
Max. amount per container in pounds of a 
specific chemical on site on any one day 
during the reporting year

Max Amount at Location
Type the maximum amount of the reported 
chemical that was stored at this location 
during the calendar year

 

ARIZONA State Additional fields
facility e-mail facility e-mail
facility fax facility fax
owner/operator fax owner/operator fax
Regulatory POC Name Name of Facility Regulatory Point of Contact
Regulatory POC Title Title of Facility Regulatory Point of Contact

Regulatory POC Phone
Phone Number for Facility Regulatory Point 
of Contact
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Regulatory POC Fax
Fax Number for Facility Regulatory Point of 
Contact

Regulatory POC E-mail
E-mail for Facility Regulatory Point of 
Contact

Regulatory POC Street Address
Street Address for Facility Regulatory Point 
of Contact

Regulatory POC City City for Facility Regulatory Point of Contact
Regulatory POC STATE State for Facility Regulatory Point of Contact

Regulatory POC Zipcode
Zipcode for Facility Regulatory Point of 
Contact

Facility on Tribal Land
Reporting Facility located on Tribal land in 
Arizona

IF YES- Name of Indian Nation Type in the name of the Indian Nation

 

COLORADO State Additional fields
Indicate if an RMP facility Check-off if an RMP facility

Emergency procedures reviewed with local 
fire

Check-off if the facility's emergency 
procedures have been reviewed by the local 
fire dept.

 

DELAWARE State Additional fields
Site Name Specific name of the facility site

Development/Industrial Park
Name of development/industrial park in 
which the facility is located, if applicable

Site Phone
General phone number for contacting the site 
directly

Site Fax
General fax number for contacting the site 
directly

Max amount per location
Maximum amount of the substance at that 
specific location at any time

EHS components - Cas Name 1
CAS number for Extremely Hazardous 
Substance (EHS), if reporting a mixture 
which contains an EHS 

EHS components -Name 1
Name for Extremely Hazardous Substance 
(EHS), if reporting a mixture which contains 
an EHS 

Tier2*Submit User's Manual

10/30/2007 Page 35 of 83



EHS components - Cas Name 2
CAS number for possible second Extremely 
Hazardous Substance (EHS), if reporting a 
mixture which contains EHSs 

EHS components -Name 2
Name for possible second Extremely 
Hazardous Substance (EHS), if reporting a 
mixture which contains  EHSs 

EHS components - Cas Name 3
CAS number for possible third Extremely 
Hazardous Substance (EHS), if reporting a 
mixture which contains EHSs 

EHS components -Name 3
Name for possible third Extremely Hazardous 
Substance (EHS), if reporting a mixture 
which contains EHSs 

EHS components - Cas Name 4
CAS number for possible third Extremely 
Hazardous Substance (EHS), if reporting a 
mixture which contains EHSs 

EHS components -Name 4
Name for possible fourth Extremely 
Hazardous Substance (EHS), if reporting a 
mixture which contains EHSs 

Fee classification per chemical reported

Fee classification per chemical.  There are 6 
options: Hazardous Chemical, Extremely 
Hazardous Substance (EHS), Mix containing 
< 10% EHS, Mix containing > 10% EHS, 
Motor Vehicle Fuel (MVF) for Retail Sale, or 
Voluntary.

Third Emergency Contact Name
Name of third emergency contact person 
(required)

Third Emergency Contact Title Title of third emergency contact

Third Emergency Contact Work Phone
Work phone number for third emergency 
contact

Third Emergency Contact 24 hour phone
24 hour phone number for third emergency 
contact

Third Emergency Contact pager Pager number for third emergency contact

Fourth Emergency Contact Name
Name of fourth emergency contact person 
(optional)

Fourth Emergency Contact Title Title of fourth emergency contact

Fourth Emergency Contact Work Phone
Work phone number for fourth emergency 
contact

Fourth Emergency Contact 24 hour phone
24 hour phone number for fourth emergency 
contact

Fourth Emergency Contact pager Pager number for fourth emergency contact
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Fifth Emergency Contact Name
Name of fifth emergency contact person 
(optional)

Fifth Emergency Contact Title Title of fifth emergency contact

Fifth Emergency Contact Work Phone
Work phone number for fifth emergency 
contact

Fifth Emergency Contact 24 hour phone
24 hour phone number for fifth emergency 
contact

Fifth Emergency Contact pager Pager number for fifth emergency contact

Regulatory POC-Name
Name of person to contact for regulatory and 
compliance issues

Regulatory POC-Title
Title of person to contact for regulatory and 
compliance issues

Regulatory POC-Phone
Phone number of person to contact for 
regulatory and compliance issues

Regulatory POC-E-mail
E-mail address of person to contact for 
regulatory and compliance issues

Regulatory POC-Fax
Fax number of person to contact for 
regulatory and compliance issues

Regulatory POC - Street Address
Street address of person to contact for 
regulatory and compliance issues

Regulatory POC - City
City of person to contact for regulatory and 
compliance issues

Regulatory POC - ST
State of person to contact for regulatory and 
compliance issues

Regulatory POC - Zip
Zip Code of person to contact for regulatory 
and compliance issues

 

GEORGIA State Additional fields

County
Indicate the county where the facility is 
located

Mailing address
Fill the correct mailing street address, city, 
state and zipcode for the reporting facility

 

HAWAII State Additional fields
Indicate Island Hawaii, Kauai, Maui, Lanai, Molokai, Oahu
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INDIANA State Additional fields

Fire District
Type in the Fire Department District where 
the facility is located

Facility Type
Choose from Federal Gov, State Gov, Local 
Gov, Private Agriculture, Private Industrial

First Time Filing Check off if this is the first Tier II filing in IN

Updated Filing
Check off if this is an update to the annual 
Tier II filing

EPCRA 302 Submission
Check off if this is the facility's EPCRA 302 
filing

EPCRA 311 Submission
Check off if this is the facility's EPCRA 311 
filing

Emergency Procedures Reviewed
Check off if the facility's emergency 
procedures have been reviewed by the 
LEPC / Fire Dept

Emergency Plans Submitted to the LEPC/Fire 
Dept.

Check off if the facility's emergency plans 
have been submitted to the LEPC and Fire 
Dept

Indicate Number of Chemicals Included
Type in the total number of chemicals 
included with this submission

Indicate Number of EHS Chemicals Included
Type in the number of EHS chemicals 
included with this submission

Indicate Previous Facility Name (if known)
Type in the previous name of the facility, if 
unknown type N/A or unknown

Indicate Previous Parent Company/Owner (if 
known)

Type in the previous Parent Company or 
Facility Owner, if unknown type N/A or 
unknown

Indicate Number of Facilities in IN for this 
owner

Type in the total number of facilities in IN for 
this owner

LEPC
Type in the Name of the Local Emergency 
Planning Committee for this facility

Facility ID Number
Type in the IN Facility ID number for this 
facility

 

MAINE State Additional fields
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Mode of Shipment
Check off the mode of shipment for the 
chemical: Truck, Tank Truck, Rail Car, Tank 
Car, Pipeline, Barge, Other (Specify in text) 

Frequency of Shipment filer enters #
Frequency of Shipment then checks- wk, month, yr
Max capacity per single vessel Maximum capacity per single vessel
Max Quantity of Shipment in Lbs Total amount of shipment
Avg Quantity of Shipment in lbs Average amount of shipment
Physical state in transit Solid, Liq, or Gas

Packaging code

Use same list as Storage Codes: A=Above 
ground tank B=Below ground tank C=Tank 
inside building D=Steel Drum E=Plastic or 
non-metallic drum F=Can G=Carboy H=Silo 
I=Fiber Drum J=Bag K=Box L=Cylinder 
M=Glass bottle or jug N=Plastic bottle or jug 
O=Tote Bin P=Box Car Q=Tank Car R=Tank 
Truck S=Pipeline T=other

Comments
provide both the primary and alternate routes 
of travel

Carrier
Name of the Company that is transporting the 
chemical

Carrier Street Address Company Street Address
Carrier City Company City
Carrier STATE Company STATE
Carrier ZIPCODE Company ZIPCODE
Carrier telephone Company telephone
Carrier Emergency Contact - Name Company Emergency Contact - Name

Carrier Emergency Contact - Phone Number
Company Emergency Contact - Phone 
Number

24-HOUR CARRIER TELEPHONE
Company 24-HOUR CARRIER 
TELEPHONE

 

OHIO State Additional fields

Initial Filing (First Time Filer)
Check off if this is the first Tier II filing in 
OH

Updated Filing
Check off if this is an update to the annual 
Tier II filing
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Annual Filing
Check off if this is the facilities annual Tier II 
filing

Facility Name Change
Check off if Facility has changed names in 
the past reporting year

Confidential Location Forms Included
Check off if the submission includes 
Confidential Location Forms for Chemical 
Storage Locations 

Owner/Operator has changed
check off if the owner /operator has changed 
in the past reporting year

Total EHS Chemicals Included
Type in the number of EHS included with 
this submission

Number of Chemicals Included
Type in the total number of chemicals 
included with this submission

Site or Operating Division Name
Name of Facility's Site or Operating Division 
Name if applicable

Name of previous facility name (if known) Type in the old facility name if it has changed
Name of previous parent company/owner (if 
known)

Type in the previous parent company or 
owner if the owner has changed

Fee classification for this reported substance
Pick either EHS, Hazardous or Voluntary for 
the pull down list

 
ATTENTION Ohio facilities : 
1.) Dun & Bradstreet and SIC codes are required 
2.) Number of Employees is required 
3.) 2nd Emergency Contact is required (both Emergency Contacts are required to list 
e-mail and fax#) 
4.) Local Fire Department Contact is required (use "Fire Department" from the 
Contact Type pull down list)  
5.) Regulatory Point of Contact is also required  
6.) Ohio facilities must submit a site plan once every three years and check off "I 
have submitted a site plan" in the Certification tab 
6.) The "location" field under the Storage Locations tab must be completed in the 
following manner: 

A.  Enter the Building, Tank or Area number (B, T or A) which corresponds to the facility 
map you prepared 

B.  Enter the Room number or division from your facility map 
C.  Identify the floor (above or below ground level)  

 
Example: B1 Room 101 Ground Floor 
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OKLAHOMA State Additional fields

Number facilities in State
total number of facilities reported for the 
State for a specific Owner/Operator

 

SOUTH CAROLINA State Additional fields

Max in Largest Vessel
Maximum amount of chemical in largest 
vessel in pounds

 

SOUTH DAKOTA State Additional fields
payment # code used in state
No change in chemical amount Check-off box indicating no change

 

TEXAS State Additional fields
County County where the facility in located
Initial Filing Check box if this is an initial filing.
Updated Filing Check box if this is an updated filing.
Annual Filing Check box if this is an annual filing.

Confidential Locations Included
Confidential Chemical Storage Included in 
the submission.

Consolidating Facilities Facilities are being consolidated.

EPCRA 302
Checkbox if this is an EPCRA 302 
submission.

 

VERMONT State Additional fields
Record of reporting years Years reported (Example: 96,97,98,99,00)
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CHAPTER 4 - Modify Tier II information 

In this Chapter you will learn how to modify your Tier II information within Tier2 
Submit. This chapter includes instructions on how to:  
 

●     Add a Facility 
●     Add a Contact 
●     Add a Chemical  

 
●     Delete a Facility 
●     Delete a Contact 
●     Delete a Chemical  

 
●     Change a Facility 
●     Change a Contact 
●     Change a Chemical 
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Add Facility 

There are two ways to add a facility 

●     To add a facility that has similar Facility, Contact or Chemical information to a 
previously entered facility.  
 
- Click the rolodex icon on the left of the window to scroll through any 
previously entered facilities, choose the facility that is the most similiar to the 
new facility you would like to enter.  
 
- Go to the Record menu on the top menu of the program and choose 
Duplicate facility. Now you may navigate through the windows to enter/edit the 
data for the new facility as appropriate.  
 

●     To start a completely new facility record - Simply click the  button 
on the top of the window. 
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Add Contact 

1.  Click the  button on top of the window (Tier2 Submit will list the 
contacts already associated with the selected facility).  
 

2.  Click the  button from the top of the window.  
 

3.  Enter all the appropriate contact data into the fields.  
 
In the third block you must associate the new contact to one or more facilities.  
 

4.  Click the "Add Facility" button.  
 

5.  Click on the facility you want to add the contact to ( The facility will have the 
little black bar to the left of the year when selected).  
 

6.  Then click the "Select" button.  
 
Repeat steps 4-6 if you would like to associate this new contact with any other 
facilities. 
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Add a Chemical to Inventory 

If you have more than one facility entered into Tier2 Submit here is a quick tip ( If you 
only have one facility skip to step 2). 

1.  Click the Rolodex icon on the left side of the window to "flip" through the 
facility records you have already entered - Choose the facility record that you 
would like to add a chemical to, then...  
 

2.  Click the  button on the top of the window.  
 

3.  Click the  button on top of the window.  
 

4.  Enter all the appropriate data. 
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Delete Facility 

1.  Click the  button from the top of the window.  
 

2.  Click on the Facility you would like to delete ( a little black bar to the left of the 
year indicates that the record is selected).  
 

3.  Go to Record from the top menu bar and choose "Delete Facility".  
 
Quick tip - Use the Rolodex on the left side of the window to choose the facility 
you want to delete then go to the Record on the top menu bar and choose 
Delete Facility. 
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Delete Contact 

1.  Click the  button from the top of the window.  
 

2.  Click on the Contact you would like to delete ( a little black bar to the left of the 
last name indicates that the record is selected).  
 

3.  Go to Record from the top menu bar and choose "Delete Contact".  
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Delete a Chemical from Inventory 

1.  Click the  button from the top of the window.  
 

2.  Click on the Chemical you would like to delete ( a little black bar to the left of 
the last name indicates that the record is selected).  
 

3.  Go to Record from the top menu bar and choose "Delete Chemical in 
Inventory".  
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Change a Facility's information 

1.  Click the  button from the top of the window.  
 

2.  Click on the Facility you would like to change ( a little black bar to the left of 
the year indicates that the record is selected).  
 

3.  Click the  button.  
 

4.  Proceed to navigate through the data fields to change the appropriate 
information.  
 
The program will save any changes automatically. 
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Change a Contact's information 

1.  Click the  button from the top of the window.  
 

2.  Click on the Contact you would like to change ( a little black bar to the left of 
the last name indicates that the record is selected).  
 

3.  Click the  button from the top of the window.  
 

4.  Proceed to navigate through the contact's data fields to change the 
appropriate information.  
 
In the third block you can associate the contact with more facilities.  
 

5.  Click the "Add Facility" button.  
 

6.  Click on the facility you want to add the contact to ( The facility will have the 
little black bar to the left of the year when selected).  
 

7.  Then click the "Select" button.  
 
The program will save any changes automatically 
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Change a Chemical's information 

1.  Click the  button from the top of the window.  
 

2.  Click on the Chemical you would like to change ( a little black bar to the left of 
the last name indicates that the record is selected).  
 

3.  Click the  button from the top of the window.  
 

4.  Proceed to navigate through the chemical's data fields to change the 
appropriate information.  
 
The program will save any changes automatically. 

Tier2*Submit User's Manual

10/30/2007 Page 51 of 83



CHAPTER 5 - Validating Data 

Validation  
 
Validation is Tier2 Submit's way of checking that the minimum required fields for Tier 
II Chemical Inventory Reports are complete. This saves time for both the receiving 
agency and the reporting facility.  
 
To save time validate after you enter each facility.  
 

●     After you have entered all of the facility, contact and chemical information - Go to the 
facility record you wish to validate then go to Record from the top menu bar and 
choose "Validate Record".  
 

●     If the minimum fields for submission are complete a pop up window will appear 
stating that the facility has passed all validation checks. Click the "OK" button to 
complete the validation process.  
 

●     If a field did not have all the appropriate information for submission click the "Go to 
Field" button from the pop up window and correct the data. Then navigate back to 
the Facilities module (Go to the File menu choose Open and then "Facilities" from 
the list). Now check all the facility information again by going to Record from the top 
menu bar and choose "Validate Record".  
 

●     If another field did not have all the appropriate information for submission repeat the 
last step until your facility has all the minimum fields completed for submission.  
 
Make a Validation Report  
 
A user can view or print a validation report with Tier2 Submit.  
 

●     From the Facilities module go to the File menu and choose "Make Validation 
Report".  
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●     The Tier2 Submit Validation report window appears and you can choose to make a 

validation report for the Current Record or for the "Found Set" of records.  
 

●     After choosing to make a validation report for either the Found Set or the Current 
Record, another window appears. You have the choice of viewing or printing the 
validation report in this window.  
 

●     When you "view" the validation report use the File menu and "Close" to return to 
your Facility record. 
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CHAPTER 6 - Submitting Data! 

After you have validated the facility you would like to submit. Follow the submission 
steps below:  
 
If you only have one facility entered into Tier2 Submit: 

Tier2 Submit will only create submissions from the Facilities module - If you 
are not in the Facilities module - Go to File on the top menu bar then select 
"Open" and choose Facilities from the list.  
 
 

1.  Go to the File menu on the top menu bar and click "Create Submission".  
 
Found Set is the default and your Found set is the one facility you just 
entered.  
 

2.  Click the "Start Submit Validation" button.  
 
The facility passed if you completed validation before this step. If not see 
Chapter 5- Validation.  
 

3.  Click "State Submission Requirements" to double check your state's 2004 Tier 
II reporting procedures.  
 

4.  After reviewing your state's submission requirements choose either "Create 
Electronic File" (Go to step 5) or "Create Complete Paper Report" (Go to step 7) 
or "Create Original Style Paper Report" (Go to step 7).  
 
Electronic Submission  
 

5.  After you have clicked "Create Electronic File", in the "Save As" pop up 
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window type the name of the file (make a unique facility identifier (e.g.= ACME 
in Maryland reporting year 2007 = ACME_MD2007).  
 

Note: If your state prefers to receive the Tier2 Submit file on diskette or CD please 
save the facility's Tier2 Submit file to the media or if your state prefers to have the 
Tier2 Submit file e-mailed, save the zip file to an accessible directory so it can be 
attached in an e-mail message. 

 
 

New in 2006 and 2007: Tier2 Submit now has the option to save as a “t2s file” in 
addition to the “zip file” format, due to the increase in zip file restrictions. Both file 
formats will work seamlessly with CAMEOfm and Tier2 Submit. 

 
 

6.  After you have entered a unique filename and chosen the appropriate location 
to save click the "Save" button and the "Done" button on the next screen.  
 
 
Paper Submission  
 

7.  After you have clicked "Create Complete Paper Report" or "Create Original 
Style Report", click the "Print Report" button.  
 

8.  Then click "OK" on the Print set up pop up window (make sure you have 
selected the correct printer).  
 

Congratulations! Now you must either: A.) mail the diskette / CD to your State, LEPC 
and Fire Dept or B.) e-mail the zip file to your State, LEPC or Fire Dept or C.) mail the 
printed report to your State, LEPC and Fire Dept. 

 
 

 
If you have more than one facility entered into Tier2 Submit:  
 
After you have validated the facilities you would like to submit. Follow the submission 
steps below:  
 

Tier2 Submit will only create submissions from the Facilities module - If you 
are not in the Facilities module - Go to File on the top menu bar then select 
"Open" and choose Facilities from the list.  
 
To create electronic submission files (Tier II Chemical Inventory Reports 
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saved on diskette or attached to e-mail) OR printed paper Tier II Chemical 
Inventory Reports for a group of facilities you must first start a Search to 
properly select the facilities you need to submit.  
 

1.  Go to Record on the top menu bar and select "Show all Records".  
 

2.  Go to Search on the top menu bar and select "Start Search".  
 

There are several ways you can search Tier2 Submit.  
 
If you would like to submit facilities to a particular State :  
 
        - pick the State from the pull down list and then click the "Search" button.  
 
If you would like to submit facilities to a particular County :  
 
        - type the County into the "County" field and then click the "Search" button.  
 
After your search Tier2 Submit will display the found facilities in the Facilities 
module in List view. 

 
 

3.  Go to the File menu on the top menu bar and click "Create Submission".  
 
Found Set is the default and your "Found set" are the facilities you just 
searched for (e.g., only ACME Chemical facilities in Maryland).  
 

4.  Click the "Start Submit Validation".  
 
The facility passed if you completed validation before this step. If not see 
Chapter 5- Validation.  
 

5.  Click "State Submission Requirements" to double check your state's 2004 Tier 
II reporting procedures.  
 

6.  Choose either "Create Electronic File" (Go to step 7) or "Create Complete 
Paper Report" (Go to step 9) or "Create Original Style Report" (Go to step 9).  
 
Electronic Submission  
 

7.  After you have clicked "Create Electronic File", in the "Save As" pop up 
window type the name of the file (make a unique facility identifier (e.g.= ACME 
facilities in Maryland reporting year 2007 = ACME_MD2007.zip).  
 
Note: The Tier2 Submit submission file can consist of multiple facilities!  
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Note: If your state prefers to receive the Tier2 Submit file on diskette or CD please 
save the facilities Tier2 Submit file to the media or if your state prefers to have the 
Tier2 Submit file e-mailed, save the zip file to an accessible directory so it can be 
attached in an e-mail message. 

 
 

New in 2006 and 2007: Tier2 Submit now has the option to save as a “t2s file” in 
addition to the “zip file” format, due to the increase in zip file restrictions. Both file 
formats will work seamlessly with CAMEOfm and Tier2 Submit. 

 
 

8.  After you have entered a unique filename and chosen the appropriate location 
to save click the "Save" button and the "Done" button on the next screen.  
 
 
Paper Submission  
 

9.  After you have clicked "Create Complete Paper Report" or "Create Original 
Style Report", click the "Print Report" button.  
 

10.  Then click "OK" on the Print set up pop up window (make sure you have 
selected the correct printer).  
 

Congratulations! Now you must either: A.) mail the diskette / CD to your State, 
LEPC and Fire Dept or B.) e-mail the zip file to your State, LEPC or Fire Dept or 
C.) mail the printed report to your State, LEPC and Fire Dept.  
 
If you need to make multiple submissions (to another state or another LEPC) - 
return to step 1 to start a new search and submit again. 

 
Note: If you have created an electronic submission zip file, do not attempt to open 
the file directly. These files are designed to only be read by Tier2 Submit or 
CAMEOfm.  
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CHAPTER 7 - Importing / Exporting 

To import Tier2 Submit submissions*:  
 
New in 2006 and 2007: Tier2 Submit now has the option to save as a “t2s 
file” in addition to the “zip file” format, due to the increase in zip file 
restrictions. Both file formats will work seamlessly with CAMEOfm and Tier2 
Submit. 

 
 

1.  Save the zip files (Tier2 Submit submissions) to a single directory (folder) on 
your computer or network. 
 
For example: C:\Tier II submissions 
 
From the Facilities module in Tier2 Submit ( If you are not in the Facilities 
module go to File on the top menu bar and click "Open" and then select 
"Facilities" from the list).  
 

2.  Go to File from the top menu bar and click "Import/Export".  
a.  If you are importing multiple zip files check the "Batch (multiple file) 

Import" box before step 3.  
 

3.  Click the "Import Files" button on the next window. 
 

4.  On the pop up window browse to find the directory where you saved the zip file
(s) (Tier2 Submit submissions).  
 
Example: C:\Tier II Submissions 
 

5.  Highlight the zip file and click the "Open" button.  
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a.  If you are importing multiple zip files select the first zip file in the 
directory. All zip files will be imported into Tier2 Submit 2007 from that 
directory.  
 

6.  Click "OK" on the next pop up window and then click "Done" on the following 
screen. 

 

* Tier2 Submit 2007 will only take zip files created by Tier2 Submit 2003 and later.  If 
you have a submission from Tier2 Submit 2001 or 2002 and do not have access to 
Tier2 Submit 2002 or 2003, contact the RMP Reporting Center at 301-429-5018 or e-
mail: userrmp.usersupport@csc.com. Monday-Friday 8am-4:30pm eastern. 

 
If you would like to import your Tier2 Submit data in CAMEO see Chapter 7 of 
the CAMEOfm User's Manual. CAMEOfm and the User's Manual can be 
downloaded from http://www.epa.gov/osweroe1/content/cameo/index.htm  
 

Exporting Tier2 files:  
 
Exporting should NOT be utilized by a reporting party. Exporting is a function for 
receiving agencies ONLY. States, LEPCs and Fire Depts. can use this command to 
export Tier2 Submit files to CAMEO or another program.

New in 2006 amd 2007: Tier2 Submit now has the option to save as a “t2s file” in addition 
to the “zip file” format, due to the increase in zip file restrictions. Both file formats will 
work seamlessly with CAMEOfm and Tier2 Submit. 

 
To export a particular group of facilities you must first start a Search to properly 
select the facilities you need to export. 

 
 

1.  Go to Record on the top menu bar and select "Show all Records".  
 

2.  Go to Search on the top menu bar and select "Start Search".  
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There are several ways you can search Tier2 Submit.  
 
If you would like to export facilities from a particular State :  
 
        - pick the State from the pull down list and then click the "Search" button.  
 
If you would like to export facilities from a particular County :  
 
        - type the County into the "County" field and then click the "Search" button.  
 
If you would like to export a single facility out of your list of facilities:  
 
        - type the facility name into the "Facility Name" field and then click the 
"Search" button.  
 
(Or simply pick the facility from the Facility List and choose "Current Record" 
from the Import/Export screen).  
 
After your search Tier2 Submit will display the found facilities in the Facilities 
module in List view. 

 
 

3.  Go to the File menu on the top menu bar and click "Import/Export".  
 
Found Set is the default and your Found set are the facilities you just 
searched for (i.e only facilities in VT).  
 

4.  Click the "Export Files" button.  
 

5.  In the "Save As" pop up window type the name of the file (make a unique 
facility identifier (e.g.= All facilities in Vermont reporting year 2007 = 
VT_Tier2_2007.zip).  
 

6.  Click "Save" and then click "Done". 
 

The zip file created after a Tier2 Submit submission or export is CAMEO import 
ready! See Chapter 7 of the CAMEOfm User's Guide for details.  
 
CAMEOfm and the User's Manual can be downloaded from http://www.epa.gov/
osweroe1/content/cameo/index.htm 
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CHAPTER 8 - Reference Information 

This chapter contains basic reference information you may find useful as you work 
with Tier2 Submit: explanations of the functions of Tier2 Submit button commands, 
menu commands, data descriptions and an overview of the legislation on which Tier 
II Chemical Inventory reports are based. 
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Frequently Asked Questions 

 
Tier2 Submit FAQs are now available at: http://www.epa.gov/osweroe1/content/epcra/
tier2submitfaq.htm 
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Hot Buttons 

 
Tier2 Submit has hot buttons which allow the user to navigate from module to 
module ( e.g.= from Facilities to Chemical in Inventory ) and between Record view 
and List view.  
 
Record view is the default view and is best for entering new or editing old data within 
Facilities, Contacts or Chemicals in Inventory.  
 
List view is best for seeing all records that have been entered in Tier2 Submit ( e.g. = 
view all the facilities or all the contacts for a facility or all the chemicals in a particular 
facility's inventory).  
 
The hot buttons are located on the top of each module window in both Record view 
and List view.  
 
Below is a list of all the hot buttons and their functions organized by module.  
 

NOTE: The       button will take you to the Users Manual in any module. 

 
Facilities module (Record View) 

●      This button switches over to the List view which allows the user 
to see all the facilities that have been entered into Tier2 Submit.  
 

●      This button closes the Facilities module and opens the 
Chemical in Inventory module in List view (if there are not any chemicals 
already entered then the Chemical in Inventory Record view is opened).  
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●      This button closes the Facilities module and opens the 
Chemical in Inventory module in List view (if there are not any chemicals 
already entered then the Chemical in Inventory Record view is opened).  
 

●     This button creates a new facility record 

 
Facilities module (List View) 

●      This button switches over to the Record view which allows the 
user to add or edit information for the selected facility.  
 

●      This button closes the Facilities module and opens the 
Chemical in Inventory module in List view (if there are not any chemicals 
already entered then the Chemical in Inventory Record view is opened).  
 

●      This button closes the Facilities module and opens the 
Contacts module in List view (if there are not any contacts already entered 
then the Contacts Record view is opened).  
 

●     This button creates a new facility record  
 

●      This button only appears at the top of the window if the user 
is working with a "found set" of records.  
( e.g.= User searches Tier2 Submit for all facilities in Anne Arundel County, 
Maryland. The "found set" is only those facilities in Anne Arundel County, 
Maryland. The View all Facilities button clears the "found set" and shows all 
the facility records). 

 
Contacts module (Record View) 

●      This button switches over to the List view which allows the user 
to see all the contacts that are associated with the currently selected facility.  
 

●      This button shows all the facilities associated with the current 
contact. ( if no facilities are associated with the contact then all the facilities 
are show in List view).  
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●      This button creates a new contact record.  
 

●      This button closes the Contacts module and takes the user back 
to the Facility Record. 

Contacts module (List View) 

●      This button switches over to the Record view which allows the 
user to add or edit information for the selected contact.  
 

●      This button shows all the facilities associated with the selected 
contact. (Click on a contact to select - a black bar to the left of the last name 
indicates selection).  
 

●      This button creates a new contact record.  
 

●      This button only appears at the top of the window if the user 
is working with a "found set" of records.  

( e.g.= User clicks the  button from the Facilities module and a 
short list of three contacts appears in the next window. These three contacts 
are associated with the currently selected facility. Clicking the "View all 
Contact" button simply clears the "found set" and shows all the contacts 
records in Tier2 Submit ).  
 

●      This button closes the Contacts module and takes the user back 
to the Facility Record. 

 
Chemicals in Inventory module (Record View) 

●      This button switches over to the List view which allows the user 
to see all the chemicals associated with the currently selected facility.  
 

●      closes the Chemical in Inventory module and shows the 
currently selected facility in Record view.  
 

●      This button closes the Chemicals in Inventory module and 
opens the Contacts module in List view.  
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●      This button creates a new chemical in inventory record 
in Record view.  
 

●      This button closes the Contacts module and takes the user back 
to the Facility Record. 

Chemicals in Inventory module (List View) 

●      This button switches over to the Record view which allows the 
user to add or edit information for the selected chemical.  
 

●      closes the Chemical in Inventory module and shows the 
currently selected facility in Record view.  
 

●      This button closes the Chemicals in Inventory module and 
opens the Contacts module in List view.  
 

●      This button creates a new chemical in inventory record 
in Record view.  
 

●      This button appears at the top of the window if the 
user is working with a "found set" of chemical in inventory records. The "found 
set" are the chemicals associated with the currently selected facility.  
 

Click  to show all the Chemicals in Inventory for all 
facilities.  
 

●      This button closes the Contacts module and takes the user back 
to the Facility Record. 
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File menu 

 
Open 

Hierarchical menu which gives Tier2 Submit users access to either one of the other 
modules (Facilities, Contacts or Chemical in Inventory). Users can only have one 
module open at a time, so opening a module via this command would automatically 
close any open module.  
 
For example - The Facilities module is open and the user goes to the Open 
command from the File menu, then chooses either Contacts or Chemicals in 
Inventory - The Facilities module closes and the chosen module opens. 

Close 

This command closes the open module. 

Import/Export 

Takes user to a view in the Navigator module where options are displayed for 
importing or exporting data. This view would not otherwise be visible to users. 

Make Validation Report 

Only available from the Facility Module. Takes user to a view in the Navigator 
module where options are displayed for making a validation report. This view would 
not otherwise be visible to users. 

Create Submission 
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Only available from the Facility module. Takes user to a view in the Navigator 
module where options are displayed for submit validation then options for making 
electronic or printed Tier II reports. This view would not otherwise be visible to users. 

Exit 

Exits from the Tier2 Submit program (all data is saved automatically). 
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Edit menu 

 
Copy 

Copies selected contents of a field. 

Paste 

Pastes copied contents into an applicable field. 

Select All 

Selects all contents of a field. 

Spelling 

Check Selection - spell checks the selected text. 
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Record menu 

 
View List 

Switch to list view in the open module. 

 
View Record 

Switch to record view in the open module. 

 
Next Tab 

Opens the next tab in the open module (only applicable in Record view of the 
Facilities and Chemicals in Inventory modules).  
 
(e.g., User is in the Facilities module in Record view and the "State Fields" tab is 
open. User goes to the Record menu the clicks Next Tab and the "Certification" tab 
opens). 

 
Show Related 

In the Facilities module:  
 
Show Related Chemicals in Inventory - shows all the chemicals in inventory for the 
currently selected facility (in List view).  
 
Show Related Contacts- shows all the contacts for the currently selected facility (in 
List view).  
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In the Contacts module:  
 
Show Related Facilities- shows all the facilities that are associated with the currently 
selected contact (in List view).  
 
In the Chemicals in Inventory module:  
 
Show Related Contacts- shows all the contacts for the currently selected facility (in 
List view).  
 
Show Related Facility- shows the facility that is associated with the currently selected 
chemical (in Record view). 

 
Sort 

User can sort records by any field in each of the three modules.  
 
(e.g.= user would like to sort all the facilities (in List view) by county in the Facilities 
module- user goes to the Record menu and clicks Sort. To clear the default sort the 
user clicks the "Clear all" button then selects FCounty from list to the left then the 
"Move" button and then the "Sort" button. Now all the facilities are sorted 
alphabetically by county). 

 
Show All 

This command clears all "found sets" and shows all the records in the opened 
module. 

 
New 

In the Facilities module:  
 
New Facility - creates new facility record (in Record view).  
 
In the Contacts module:  
 
New Contact - creates new contact record (in Record view).  
 
In the Chemicals in Inventory module:  
 
New Chemical in Inventory - creates new chemical in inventory record (in Record 
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view). 

 
Duplicate 

Only available in the Facilities module.  
 
This command duplicates the currently selected facility. 

 
Delete 

In the Facilities module:  
 
Delete Facility - deletes the currently selected facility record.  
 
In the Contacts module:  
 
Delete Contact - deletes the currently selected contact record.  
 
In the Chemicals in Inventory module:  
 
Delete Chemical in Inventory - deletes the currently selected chemical in inventory 
record. 

 
Delete All 

available only from List view  
 
This command deletes all the records from the open module or all of the "found set" 
in the open module. 

 
Revert Record 

Available only from Record view  
 
Changes the current record back after changes have been made in any module. 

 
Validate Record 

Available only from the Facilities module  
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Checks all of the selected facilities' Tier II information for minimum requirements. 

 
Go To 

This command takes the user to records in each open module.  
 
First - first record in the list 
Previous- record the user was at last 
Next- next record in the list 
Last- last record of the list 
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Search menu 

 
Start Search 

Starts the Basic Tier2 Submit search window where a user can search within each of 
the three modules. 

Append Search 

Starts the Basic Tier2 Submit search where a user can add to the existing search for 
better or broader results. 

Subset Search 

Starts the Basic Tier2 Submit search window where a user can search the "found 
set" in any module to narrow results. 

Clear Search 

Clears the previous search results' "found set". 
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Scripts Menu 

The Scripts Menu - no commands are available in this menu for Tier2 Submit 

 
 
Help menu 

 
Tier2 Submit Help  
 
This is the only command under the Help menu. Takes the user to this manual. 
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Statutes and Regulations 

What is the Emergency Planning and Community Right-to-Know Act (EPCRA)? 

The Emergency Planning and Community Right-to-Know Act of 1986 establishes 
requirements for Federal, State and local governments and industry regarding 
emergency planning and "Community Right-to-Know" reporting on hazardous and 
toxic chemicals. This law built upon EPA's Chemical Emergency Preparedness 
Program (CEPP) and numerous State and local programs aimed at helping 
communities to better meet their responsibilities in regard to potential chemical 
emergencies. The Community Right-to-Know provisions, through the creation of 
State Emergency Response Commissions and Local Emergency Planning 
Committees, help increase the public's knowledge and access to information on the 
presence of hazardous chemicals in their communities and releases of these 
chemicals into the environment. States and communities, working with facilities, will 
be better able to improve chemical safety and protect public health and the 
environment. 

Regulations 

●     EPCRA Regulations: 40 CFR Chapter I, Sub-chapter J  
●     Amendments to Hazardous Chemical Reporting Thresholds, Streamlining 

Requirements. 40 CFR Parts 355 and 370 (Signed May 21, 1998; Published 
June 8, 1998) (HTML)  
 

●     Emergency Planning and Community Right-to-Know Programs; Amendments 
to Hazardous Chemical Reporting Thresholds for Gasoline and Diesel Fuel at 
Retail Gas Stations; Final Rule (Signed February 4, 1999; Published February 
11, 1999) (HTML) 
Also available in PDF.  
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For more Tier II information please see EPCRA Information 
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How to report your facility latitude and longitude

There are four data elements to report for latitude and longitude: 

1.  Lat/long Description 
2.  Lat/Long Method 
3.  Reporting the Latitude and Longitude 

1.) Choosing your Lat/Long Description  
 
You will first need to choose your Lat/Long "Description" which represents the exact 
location of your latitude and longitude values. The most common Lat/Long 
"Descriptions" are "PG" for Plant Gate or entrance and "CE" indicates the Center of 
your facility. Tier2 Submit contains a list of codes to be used for this element.  
 
Latitude and Longitude Description of Reference Point Codes  
 
AB- Administrative Building: a building, structure, or portion thereof that houses the administrative functions of 
a facility as opposed to production or manufacturing activities. 
 
AE- Atmospheric Emissions Treatment Unit: equipment installed for the express purpose of treating chemical 
emissions prior to their release into the atmosphere. 
 
AM- Air Monitoring Station: equipment installed at a predetermined location for the automatic, manual, or 
periodic collection of environmental air samples. 
 
AS- Air Release Stack: a free-standing vertical structure constructed for the conveyance and release of 
chemical emissions into the air. 
 
AV- Air Release Vent: a horizontal structure constructed for the release of chemical emissions into the air, 
typically from the side or roof of a building. 
 
CE- Center of Facility: a representative center point within the boundary of a facility. FC Facility Centroid: the 
calculated center of a contiguous facility. 
 
IP- Intake Pipe: a pipe or intake opening constructed for the collection and conveyance of water. 
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LC- Loading Area Centroid: the calculated center of a portion of a facility associated with loading activities. 
 
LF- Loading Facility: the portion of a facility associated with loading and/or transshipment activities. 
 
LW- Liquid Waste Treatment Unit: Equipment installed for the express purpose of treating chemical emissions 
prior to their release to water, publicly owned treatment works (POTW) or off-site transfer. 
 
NE- NE Corner of Land Parcel: the northeast most corner or boundary of a land parcel. 
 
NW- NW Corner of Land Parcel: the northwest most corner or boundary of a land parcel. 
 
OT- Other. 
 
PC- Process Unit Area Centroid: the calculated center of a portion of a facility associated with processing and/
or manufacturing activities. 
 
PF- Plant Entrance (Freight): the entrance to a facility associated with transshipment activities. 
 
PG- Plant Entrance (General): the front gate or general entrance of a facility. 
 
PP- Plant Entrance (Personnel): the entrance to a facility associated with employees. 
 
PU- Process Unit: the portion of a facility associated with processing and/or manufacturing activities. 
 
SD- Solid Waste Treatment/Disposal Unit: the portion of a facility associated with the treatment and/or disposal 
of solid waste. 
 
SE- SE Corner of Land Parcel: the southeast most corner or boundary of a land parcel. 
 
SP- Lagoon or Settling Pond: the portion of a facility designed to accommodate sedimentation or settling of 
chemical by-products necessitated by the manufacture, production, or use of chemicals. 
 
SS- Solid Waste Storage Area: the portion of a facility associated with the storage of solid waste. 
 
ST- Storage Tank: a receptacle or chamber used for storing bulk fuels or chemicals. 
 
SW- SW Corner of Land Parcel: the southwest most corner or boundary of a land parcel. 
 
UN- Unknown 
 
WA- Wellhead Protection Area: an area at the earth's surface buffering a wellhead. 
 
WL- Well: a shaft drilled in the earth for purposes such as obtaining subsurface drinking water, or collecting 
groundwater monitoring samples. 
 
WM- Water Monitoring Station: a location or study area for the automatic, manual, or periodic collection of 
water samples. 
 
WR- Pipe Release to Water: the point at which a pipe constructed for the conveyance and release of water-
borne chemical emissions reaches a water body. 
 

2.) Choosing your Method 
 
Next, you need to choose a "Method" for determining your Lat/Long. There are four 
general methods to determine your site latitude and longitude: Global Positioning 
Systems (GPS); Geographic Information Systems (GIS); Internet Internet based 
finders; and paper maps. These methods are described below in order of accuracy 
(GPS is the most accurate way to determine a lat/long, paper maps is the least 
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accurate method). Although it is preferable that you use the most accurate method 
available to you, all four methods are acceptable. You must enter your latitudinal and 
longitudinal coordinates in decimal degrees. 
 
(a) Global Positioning Systems (GPS). If you have access to a GPS unit, take the 
reading at the place specified by the Lat/Long "Description" that you choose. Most 
GPS units allow you to choose between display in decimal degrees and degrees/
minutes/seconds. You should choose decimal degrees.  
 
(b) Geographic Information Systems (GIS). If you have your own GIS, navigate to 
your street and pinpoint the exact location that you choose for your Lat/Long 
"Description" field. Your GIS should report (usually on a status bar) the latitude and 
longitude of the focus point or map marker. Your GIS should also allow a preference 
for display in degrees/minutes/seconds or decimal degrees. Choose decimal 
degrees. 
 
(c) Internet-based address finders. There are numerous Internet sites for viewing 
maps and finding specific locations. EPA has developed the TRI Facility Siting Tool 
to allow facilities that submit Toxic Release Inventory (TRI) reports to obtain their 
latitude and longitude. This tool may also be used by facilities submitting Tier II 
Chemical Inventory reports. The tool asks you to enter either a zip code or a city and 
state. It then provides a map that you can zoom into and pan sideways, to identify 
your location. Once you get to the maximum zoom-in level, it will show a satellite 
photo over the map, to further assist in pinpointing your exact location.  
 
The TRI Facility Siting Tool can be accessed at the following web address: http://
www.epa.gov/tri/report/siting_tool/index.htm  
 
(d) Paper maps. Choose a map that shows a relatively small area, and that has 
latitude/longitude tick marks along the edges. A county map book with a small 
section of the county on each page, or a USGS topographic map is ideal. County 
map books are available in many public libraries, bookstores and office supply 
stores. USGS maps are available in many libraries or may be purchased directly 
from the USGS by submitting a written request to:  
 
Distribution Branch of the USGS 
P.O. Box 25286 
Denver Federal Center 
Denver, CO 90225 
Phone: (303) 236-5900.  
 
Do not use a common road atlas with one state map per page or state highway maps 
because they generally show too large an area to obtain adequate latitude/longitude 
value. After finding your exact location on the map, see where that point lies in 
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relation to the latitude and longitude tick marks.  
 
You must convert decimal degrees/minutes/seconds to decimal degrees. Use the 
following link from the University of Kentucky to covert degrees/minutes/seconds to 
decimal degrees - http://www.uky.edu/KGS/gis/converter.htm  
 
The table below lists all of the codes to be used for this element and provides a brief 
description of each method. 
 
Code Description of Method 
 
A1- Address Matching House Number: derived from a point corresponding to a house or building number 
along a street segment. 
 
A2- Address Matching - Block Face: derived from a calculated midpoint of one side of a street segment with 
regard to odd or even addresses. 
 
A3- Address Matching - Street Centerline: derived from a calculated midpoint and centerpoint of a street 
segment. 
 
A4- Address Matching - Nearest Intersection: derived from the intersection closest to a house or building 
number. 
 
A5- Address Matching – Primary Name: derived from the primary name of a township or city. 
 
A6- Address Matching – Digitized: derived from hands-on use of computer-based mapping tools. 
 
AO- Address Matching - Other: derived through the use of non-specific matching techniques. 
 
C1- Census Block - 2000 - Centroid: derived from the calculated centerpoint of a 2000 Census Block as 
defined by the U.S. Bureau of the Census. 
 
C2- Census Block/Group - 2000 - Centroid: derived from the calculated centerpoint of a 2000 Census Block/
Group as defined by the U.S. Bureau of the Census. 
 
C3- Census Block Tract - 2000 - Centroid: derived from the calculated centerpoint of a 2000 Census Tract as 
defined by the U.S. Bureau of the Census. 
 
CO- Census - Other: derived from other Census-defined areas, such as Metropolitan Statistical Areas (MSAs). 
 
GO- GPS-Unspecified: derived through the use of an unspecified GPS device. 
 
G1- Global Positioning System (GPS) Carrier Phase Static Relative Positioning Technique: derived through 
the use of a GPS device employing Carrier Static Relative Positioning Technique. 
 
G2- GPS Carrier Phase Kinematic Relative Positioning Technique: derived through the use of a GPS device 
employing Phase Kinematic Relative Positioning Technique. 
 
G3- GPS Code Measurements (Pseudo Range) Differentially Corrected: derived through the use of a GPS 
device where measurements have been corrected for error based on the existence of known base stations 
relative to the study area. 
 
G4- GPS Code Measurements (Pseudo Range) Precise Positioning Service: derived through the use of a GPS 
device employing real-time precise positioning techniques. G5- GPS Code Measurements (Pseudo Range) 
Standard Positioning Service SA OFF: derived through the use of a GPS device when the Department of 
Defense Selective Ability was turned off. 
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G6- GPS Code Measurements (Pseudo Range) Standard Positioning Service SA ON: derived through the use 
of a GPS device when the Department of Defense Selective Ability was turned on. 
 
G7- GPS Code Measurements (Pseudo Range) Standard Positioning Service Corrected using Canadian 
Active Control System: derived through the use of a GPS device employing the Canadian Active Control 
System. 
 
I1- Interpolation – Map: derived from a paper or other non-digital map 
 
I2- Interpolation – Photo: derived from an aerial photograph 
 
I3- Interpolation – Satellite: derived from a satellite image. 
 
I4- Interpolation - Digital map source (TIGER): derived from a digital map, mapping software or mapping tool. 
 
I5- Interpolation - SPOT: derived from a SPOT image. 
 
I6- Interpolation - MSS (Multi-spectral Scanner): derived from a MSS image 
 
I7- Interpolation - TM (Thematic Mapper): derived from a thematic mapper 
 
L1- Loran C: derived from the use of a Loran-C positioning device 
 
P1- Public Land Survey-Section: a coordinate pair corresponding to a point from a public land survey. 
 
P2- Public Land Survey-Quarter Section: a coordinate pair corresponding to a point from a public land survey 
 
P3- Public Land Survey-Eighth Section: a coordinate pair corresponding to a point from a public land survey. 
 
P4- Public Land Survey-Sixteenth Section: a coordinate pair corresponding to a point from a public land survey. 
 
P5- Public Land Survey-Footing: a coordinate pair corresponding to a point from a public Land survey. 
 
S1- Classical Surveying Techniques: derived from traditional surveying techniques associated with 
construction activities. 
 
UN- Unknown. 
 
Z1- ZIP Code-Centroid: derived from the calculated center of a U.S. postal ZIP code. 
 
Z2- ZIP+2 Code-Centroid: derived from an averaging of multiple street segments. 
 
Approximately the size of a Census Block Group. 
 
Z4- ZIP+4 Code-Centroid: derived from a calculated midpoint of one side of a street segment with regard to 
odd or even house or building numbers. 
 

3.) Reporting Latitude and Longitude  
 
Once you have your latitude and longitude values, you'll need to make sure they are 
in the proper format, you will report latitude and longitude coordinates in “decimal 
degrees.” Enter only numerical data. Do not preface numbers with letters such as N 
or W to denote the hemisphere.  
 
Default for the hemisphere is "+" for east and north. However because "+" is 
assumed by the system, you must leave that space blank for east and north. For 
west and south, enter a negative, "-," as the first character.  
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For example: Latitude 38.123456 Longitude -123.123456  
 
Be careful not to reverse your latitude and longitude coordinates. Latitude in 
the 48 contiguous states ranges from 25° to 49°, while longitude ranges from -
72° to -124°  
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